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York Technical College 

Accessibility Checklists 

 

This document contains several checklists.  With any checklist, there are general items that are not included because there are too 

many to list all possibility. In this respect, these checklists are not comprehensive; however, they do check for major issues.  For a 

complete checklist and further information regarding the Accessibility Level AA, (http://www.w3.org/WAI/WCAG20/quickref/) and select 

the areas you want to examine further.  Hyperlinks in this document are not given in “meaningful” form.  The intention of the document 

is to be printed; therefor, the links needed to be in http format so that they can be keyed in.   

Checklists Included: 

1. General Items for All Documents 

2. Video and Audio 

3. Word Documents 

4. Excel Documents 

5. PowerPoint Documents 

6. PDF Documents 

7. HTML Documents 

Important Terminology: 

• Screen Reader – A software that reads the screen to a person.  It has key stroke short cuts so that lists, headings, etc. can be 

used for “scanning” the document.  Screen readers are normally used by visually impaired users. 

• Alt Text – Alternative Text – this is used to describe an image, table, etc. so that the visually impaired user can have the text 

description read to them.  

http://www.w3.org/WAI/WCAG20/quickref/
http://www.w3.org/WAI/WCAG20/quickref/
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Checklist for General Items in All Documents 

Check 
off 

Item How to Fix 

 Color Make sure that you are not using color to convey a message.  Such as blue, red, etc.  You can 
use the color, but must use something with them so that the screen reader picks up on the 
notation.  Example: Important statements are in blue. When you decide you have a statement that 
you want in that color, put the color name in parentheses before the statement. (Blue)  For color 
on diagrams, also describe where that color is located on the diagram. 

 Color Contrast Make sure that your color contrast is WCAG AA acceptable.   

• Black on white is great.   

• If using other colors, please contact the ETC for assistance. 
If you prefer to test the colors yourself: 

•  Go to http://www.colorzilla.com/firefox/ and install Colorzilla 

• You will have an eye dropper on your menu bar in Firefox.  Click on the eye dropper and 
place it over the color.  You will then be able to read the color code. 

• Go to http://webaim.org/resources/contrastchecker/ and key in the foreground and 
background colors.  It will indicate if it passes for small and/or large text. 

 Caps • Caps are OK for abbreviations, but you must first spell out the term before using the 
abbreviation. 

• Do not use all caps.  Use sentence structure. 
All caps indicate that you are shouting. 

 Links When using links, you need to make the links meaningful.  For instance, instead of putting in 
http://www.yorktech.edu  you would: 

• Type York Tech 

• Highlight the words 

• Hyperlink (link) to the website. 
Do not put “Click Here” because it has no meaning for the screen reader. 
If a link opens in a new window, then you need to instruct students so they know how to navigate 
to the location. 

• If the link in D2L opens to a new page, then at the end of the title put in parentheses that the 
link opens in a new window/tab. 

Example:  Link ABC (Opens in a new window/tab.) 

http://www.colorzilla.com/firefox/
http://webaim.org/resources/contrastchecker/
http://www.yorktech.edu/
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Check 
off 

Item How to Fix 

 Punctuation and 
Grammar 

• Make sure your grammar and punctuation are correct. 

• Make sure that you use good sentence structure. 

• Office will automatically put a blue wiggly underline where these errors occur.  However, there 
are times when Office will indicate an error and it is not an error.  Example: Faculty.  It takes 
this as a singular noun, and will want you to write “faculty is…” instead of “faculty are…”  
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Checklist for Video and Audio Accessibility 

Check 
off 

Item How to Fix 

 Videos are 20 
minutes or shorter 
 

Too long of a video – 

• Use a video editor and cut the video into two or more pieces.  Contact the ETC for additional 
assistance. 

Want to edit the video yourself: 

• Select the software that you want to use from: 
http://download.cnet.com/windows/video-editing-softwa  

• Trim or cut out the part that you don’t want. 

• If you are taking a long video and cutting it into several smaller ones, remember to save each 
smaller part with a different name and not the name of the original video. This prevents you 
from overwriting the original video. 

• Publish the new video in MP4 format 

 Videos must be 
captioned 

• Start with a script and use it as you record. 

• Provide the script and the MP4 video to the ETC/Distance Learning for syncing together and 
placing on the YTC YouTube account.  You will be given the YouTube link to use in your 
course. 

• If you have a dictation software such as Dragon, then run it while making the video and you 
will have the script to send with the video to ETC/Distance Learning. 

 Videos must be 
captioned 

Pre-existing Video 

• If you have Dragon or another dictation software that will read computer sounds, then play the 
video while running Dragon/dictation software, to get the script 

• If you don’t have a dictation software, then contact Distance Learning for assistance. 

• You will need to provide the MP4 video to Distance Learning. Distance Learning tries to hire 
work co-ops with transcription skills to perform the transcription/synching tasks.  You will be 
provided with a YTC YouTube link for use in your course 
 

http://download.cnet.com/windows/video-editing-softwa
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Check 
off 

Item How to Fix 

 Videos must be 
captioned 

The video is not your video, but one you found on the web. 

• Check to see if there is a transcript provided. 

• YouTube automated transcripts can be entertaining to read and have a low match rate to the 
verbiage on the video.  Be sure that the transcript matches the verbiage. 

No transcript or one that is not a close match?   

• You will need to type up the transcript.  If you need assistance, contact Distance Learning or 
the ETC for assistance. 

 Audio must have a 
transcript 

If you are using audio files, then you must have a transcript for each file.  Both the audio and the 
transcript must be provided to the student. 

• You can either run a dictation software, such as Dragon, in the background to capture the 
computer sounds as you are recording the audio or read from a script. 

Pre-existing audio files that are yours? 

• You can either run a dictation software, such as Dragon, in the background to capture the 
computer sounds while you play back the audio.  

• Contact Distance Learning or the ETC for assistance. 
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Checklist for Word Documents 

Check 
off 

Item How to Fix 

 Font and Size General Information: 

• Font must be san serif which means a font that does not have “feet” on the bottom of the 
letters.  Good fonts to select are Arial, Calibri or Verdana.   

• Size must be 12 point or larger.   
How to fix: 

• First select all your text.  There are two ways, click and scroll through the document.  The 
second way is easier, on the keyboard press Control (CTL) and A together. 

• In the ribbon (commands at the top of word) in select the desired text from the font dropdown 
menu.   

• Then select the point size of 12 or larger in the point size dropdown which is the right of the 
font selection box. 

 Headings General Process: 

• The document has appropriate headings. 
o There is only one Heading 1 and it is the title of the document. 
o Heading 2’s are the names of the categories (think of an outline – Heading 2’s 

would be the large Roman Numerals) 
o Heading 3’s are items within the Heading 2’s (in an outline this would be the 

lowercase a, b, c’s) 

• You can have multiple Heading 2’s or lower.  Keep in mind the outline.  As you move to a 
new indentation in the outline, it goes to the next lower Heading. 

You can view the heading structure of your document by: 

• Clicking “View” on the ribbon in Word 

• Selecting the box for “Navigation Pane” 
How to put in the headings: 

• For headings, highlight the text for the heading.   

• On the Home tab in the ribbon (commands at the top of word, you will see the Headings on 
the right hand part), select the appropriate heading and right click on the heading. Select 
“Update Heading “X” to Match Selection. 

 All images have alt 
text 

• Right click on the image and select Format Object.   

• Select the Alt text tab (2010) or the third icon (2013) and type in the appropriate text for the 
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Check 
off 

Item How to Fix 

image in the title and description areas.  

• Remember to describe the image so that if you close your eyes you can picture the image. 

• For decorative images, type in “” in the title and description.  Screen readers will skip the 
image. 

• Remember, you do not need to add the words “picture” or “image” in your description because 
the screen reader will alert the user that the item is an image. 

 Tables have 
Headings 

• Click on the table icon (box with four-way arrow) which is to the left of the top row of the table. 

• On the ribbon (row of commands at the top of Word), select the tab for Layout. 

• Click on “Repeat Header Rows” 

 Tables have Alt Text • Right click on the table icon (box with four-way arrow) which is to the left of the top row of the 
table. 

• Select “Table Properties” 

• Click on the Alt Text tab 

• Enter the title and a description of the table in the title and description areas. 

 Tables are 
bookmarked 

To insert a bookmark: 

• Highlight the top row of your table 

• Click on Insert on the Ribbon 

• In the 6th area from the left, click on Bookmark 

• Enter a name for the bookmark (suggest it be indicative of the nature of the table, such as 
checklist for accessibility for this table.) 

 Columns If you have columns, use the column feature. Do not use the tab key to create columns. To create 
columns: 

• Go to Page Layout on the Ribbon 

• Click on Columns (use the down arrow below the button) 

• Select More Columns 

• Select the number of columns 

• There is selection area on the bottom left of the screen (Apply to) where you can select the 
whole document or the selected text.  Make the appropriate selection. 

 Lists are bulleted • Use the bullets (unnumbered or numbered from the ribbon) 

• Bullets are in the third category from the left (Paragraph).  The unnumbered bullets are the dot 
with a line after it.  There are several symbols that you can use, but it is preferred that you use 
a circle bulleted (empty or filled in.) For numbered bullets, any of the formats given in the 
numbered list option are OK. 
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Check 
off 

Item How to Fix 

 Blank Characters Do you have additional rows between paragraphs or at the end of your document?  If so, then 
these are called blank characters. 

• Highlight the selected blank rows and delete. 

 Word Accessibility 
Checker 

• Your document has to in Word 2010 or later for the checker to work.  If it is not then save your 
document in the appropriate format.  

How to run the checker: 

• Click on the File tab in the upper left of the ribbon 

• Click on Check for Issues 

• Click on Check Accessibility 
If issues are found, then correct the issues by clicking on the individual issue and reading the 
“How to Fix” information at the bottom of the column. 
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Checklist for Microsoft Excel 

Check 
off 

Item How to Fix 

 Font and Size General Information: 

• Font must be san serif which means a font that does not have “feet” on the bottom of the 
letters.  Good fonts to select are Arial, Calibri or Verdana.  

• Size must be 12 point or larger.   
How to fix: 

• First select all your text.  There are two ways, click and scroll through the document.  The 
second way is easier, on the keyboard press Control (CTL) and A together. 

• In the ribbon (commands at the top of word) in select the desired text from the font dropdown 
menu.   

• Then select the point size of 12 or larger in the point size dropdown which is the right of the 
font selection box. 

 Headings General Process: 

• The document has appropriate headings. 
How to put in the headings: 

• For headings, highlight the text for the heading.   

• On the Insert tab in the ribbon (commands at the top of word, you will see the Header & Footer 
on the right hand part), click on Header & Footer 

• Click on Header at the right and add the appropriate text.   

• Press Enter 

 All images have alt 
text 

• Right click on the image and select Format Object.   

• Select the Alt text tab (2010) or the third icon (2013) and type in the appropriate text for the 
image in the title and description areas.  

• Remember to describe the image so that if you close your eyes you can picture the image. 

• For decorative images, type in “” in the title and description.  Screen readers will skip the 
image. 

 Tables have 
Headings 

• When you create the table within an Excel Spreadsheet, you need to also click on “My Table 
has Headers”. 

 Charts must have alt 
text for the title of 
the chart and the 
description of chart. 

When you insert a chart into an Excel spreadsheet, you need to have the chart defined with some 
alt text. 

• Right click on the chart edge and select Format 

• Select the Alt text tab (2010) or the third icon (2013) and type in the appropriate text for the 
image in the title and description areas.  
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Check 
off 

Item How to Fix 

 Excel Accessibility 
Checker 

• Your document has to in Excel 2010 or later for the checker to work.  If it is not then save your 
document in the appropriate format.  

How to run the checker: 

• Click on the File tab in the upper left of the ribbon 

• Click on Check for Issues 

• Click on Check Accessibility 

• If issues are found, then correct the issues by clicking on the individual issue and reading the 
“How to Fix” information at the bottom of the column. 
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Checklist Microsoft PowerPoint 

Check 
off 

Item How to Fix 

 Font and Size General Information: 

• Font must be san serif which means a font that does not have “feet” on the bottom of the 
letters.  Good fonts to select are Arial, Calibri or Verdana 

• Size must be 24 point or larger.   
How to fix: 

• First select all your text.  There are two ways, click and scroll through the document.  The 
second way is easier, on the keyboard press Control (CTL) and A together. 

• In the ribbon (commands at the top of word) in select the desired text from the font dropdown 
menu.   

• Then select the point size of 24 or larger in the point size dropdown which is the right of the 
font selection box. 

 Headings General Process: 

• Each slide has appropriate headings. 
How to put in the headings using PowerPoint 2010 and 2013: 

• First Click on the Home Tab,  

• The Slides commands are the second set of commands on the ribbon from the left edge.  Click 
on Reset. 

• Fill in a unique title in the title box at the top of the slide 

• To make the title invisible, click on the Home Tab and go to the Drawing section on of the 
ribbon (second area from right edge) 

• Click on Arrange and then Selection Pane  

• On the right side of the screen you will have a panel open which is called Selection. Click on 
the eye icon next to the slide title text box.  When you see the eye, the title is visible; when you 
see the dash, the title is invisible. 

 All images have alt 
text 

• Right click on the image and select Format Object.   

• Select the Alt text tab (2010) or the third icon (2013) and type in the appropriate text for the 
image in the title and description areas.  

• Remember to describe the image so that if you close your eyes you can picture the image. 

• For decorative images, type in “” in the title and description.  Screen readers will skip the 
image. 

 Tables need alt text 
and Headings 

• Right click on the edge of the table. 

• Select “Format Shape” 
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Check 
off 

Item How to Fix 

• Click on Alt Text  
o Bottom of left menu in 2010 
o Third icon on the Format Shape panel on right in 2013 

• Enter the title and a description of the table in the title and description areas. 

 Color • Be sure to check color of the background and font colors. For more information see the color 
checklist items in the All Documents checklist. 

 PowerPoint 
Accessibility 
Checker 

• Your document has to in PowerPoint 2010 or later for the checker to work.  If it is not then 
save your document in the appropriate format.  

How to run the checker: 

• Click on the File tab in the upper left of the ribbon 

• Click on Check for Issues 

• Click on Check Accessibility 

• If issues are found, then correct the issues by clicking on the individual issue and reading the 
“How to Fix” information at the bottom of the column. 
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Checklist for PDF Files 

Begin by creating your file in Word and using the accessibility checklist for Word. 

Check 
off 

Item How to Fix 

 PDF Checker • Open your document using Adobe Acrobat Pro 

• Go View on the Menu Bar 

• Select Tools and move the mouse over to the right pop-up menu and select Accessibility 
(near the bottom of the menu) 

• A side menu appears on your document that is open to Accessibility 

• Click on Full Check and then Start Checking which is at the bottom of the pop-up menu. 

• When the check is over, you will have a report on the left.  Check the issues and modify to 
resolve the issues. 

• This document may give you more insight as to any issues you incur. It was written for 
Adobe Acrobat X and we are using XI.  Please use the instructions above for how to 
access the checker. 

• http://www.adobe.com/content/dam/Adobe/en/accessibility/products/acrobat/pdfs/acrobat-
x-accessibility-checker.pdf  

  

http://www.adobe.com/content/dam/Adobe/en/accessibility/products/acrobat/pdfs/acrobat-x-accessibility-checker.pdf
http://www.adobe.com/content/dam/Adobe/en/accessibility/products/acrobat/pdfs/acrobat-x-accessibility-checker.pdf
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Checklist for HTML Files 

HTML files can be created before you take the file into D2L or by using Create a File in Content or by using the description editors on 

the tools.  If you are creating the document before taking it into D2L, create it in word and make sure that it passes all the word 

accessibility tests.   

• Click on “Save As” 

• Select “Web Page, Filtered” 

• To the left of “Save,” you will see the word “Tools”.  Click on “Tools” 

• Click on “Web Options” 

• Under the “Encode” tab, select Unicode  (UTF – 8) 

• Note: This format will allow you to make changes to the document in D2L at a later point without getting strange characters 

within the text. 

• Upload the Web Page, Filtered document (HTML) into D2L and link it to the area where you want it. 

When creating the document in D2L or using another HTML editor, then use the table below as general guidelines. 

Check 
off 

Item How to Fix 

 Font and Size General Information: 

• Font must be san serif which means a font that does not have “feet” on the bottom of the 
letters.  Good fonts to select are Arial, Calibri or Verdana. 

• Size must be 12 point or larger.   
How to fix: 

• First select all your text.  There are two ways, click and scroll through the document.  The 
second way is easier, on the keyboard press Control (CTL) and A together. 

• In the editor’s menu select the desired text from the font dropdown menu.   

• Then select the point size of 12 or larger in the point size dropdown which is the right of the 
font selection box. 

 Headings General Process: 

• The document has appropriate headings. 
o There is only one Heading 1 and it is the title of the document. 
o Heading 2’s are the names of the categories (think of an outline – Heading 2’s would be the 

large Roman Numerals) 
o Heading 3’s are items within the Heading 2’s (in an outline this would be the lowercase a, 

b, c’s) 
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Check 
off 

Item How to Fix 

• You can have multiple Heading 2’s or lower.  Keep in mind the outline.  As you move to a new 
indentation in the outline, it goes to the next lower Heading. 

How to put in the headings: 

• Place the title of the document in the “title” line.  It will be automatically labeled as a heading 1. 

• For headings, highlight the text for the heading.   

• Select from the editor’s command list the heading you wish.  The default is generally 
“Paragraph” which is the same as “Normal” in word. 

 All images have alt 
text 

• When using an html editor, most require you to put in the alt text as you upload the picture. 

• For D2L, Select “Create a File”, click on the picture icon, upload the picture, select the 
destination, and click Add.  At this point you will need to add in the description.  If the picture is 
decorative, then check the box for decorative images. 

 Tables have 
Headings and Alt 
Text 

• In most html editors, when you select the create a table command, you will have a menu for 
the number of rows and columns, after making those selections, click on the advanced tab and 
add an ID or Heading (depends on the editor) 

• On the summary or alt text line (depending on the editor) include your alt text. 

 Tables should be 
bookmarked 

• Many html editors do not include a bookmark option; however, if it does include it, it will 
typically be under the insert command area. 

 Lists are bulleted • Use the bullets from the editor’s menu. 

 Blank Characters Do you have additional rows between paragraphs or at the end of your document?  If so, then 
these are called blank characters. 

• Highlight the selected blank rows and delete. 

 HTML Checker • Go to: http://achecker.ca/checker/index.php and upload your html document from your 
computer. (You can retrieve the file from the Manage Files area.)  

• Click on the “Check It”  

• There are three errors that are shown in the report that you can ignore (placing them in D2L 
corrects these issues).  However, here are the corrections for html pages. 

o 2.4 Navigable: Provide ways to help users navigate, find content, and determine 
where they are. 

▪ Success Criteria 2.4.2 Page Titled (A) 
▪ Check 50: Document missing title element. 
▪ How to Correct: 

• Take the heading 1 for your page and change it title.  With code it 
would be  

http://achecker.ca/checker/index.php
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Check 
off 

Item How to Fix 

<title>Write your title in this area</title> and is the first line after the 
<meta content> lines. 

o (2 errors) 3.1 Readable: Make text content readable and understandable 
▪ Success Criteria 3.1.1 Language of Page (A) 
▪ Check 48: Document language not identified 
▪ Check 49: Document has invalid language code 
▪ How to correct both errors 

• On the next line after <head>, use the code given on the next bullet 

• <meta content="en-us" http-equiv="Content-Language" />.  Note if 
your language is not US English, go to 
http://www.w3schools.com/tags/ref_language_codes.asp  and replace 
the “en-us” with “your code from page” 

• Make corrections for any other Known Errors that are indicated in your file.  

 

Note:  If you copy and paste an office product into D2L, then  

• For italics on a word document that has been pasted into D2L, change the <i> to <cite> for a book title or <em> for anything else.  

Change the </i> to </cite> (if you used <cite>) or </em> (if you used <em>. 

• For bold, change the <b> to <strong> and the </b> to </strong>. 

Suggestion, open the editor and click on <> in the bottom right.  Copy the whole file and paste in word.  Use “Find” and then fix it.  Then 

copy the revised code.  Replace the code in the document with the revised code. 

http://www.w3schools.com/tags/ref_language_codes.asp
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